zipForm® 6 Training

zipForm® 6 Training

Filling out forms electronically

Training Time : 60 Minutes
Trainer: Cassandra Davis

www.ziplogix.com/zf6

support.ziplogix.com Ziprorm 6 ’)

Notes:

Why work on zipForm® 67

Save time filling out forms
Instant access to your files
Convenient tools
Professional contracts

B LOGUEF. | PROPLE o 558007 - il suFFoRi

Wy Profile Library Manager  RELAY Manager

www.zipLogix.com/zf6



zipForm® 6 Training

zipForm® 6 Training

Accessing zipForm® 6
1. From your desktop (zipForm® 6 Standard)
2. From any internet browser (zipForm® 6 Professional)

Opening and filling out forms
Saving time using

The Cover Sheet or Transaction Data Sheet
Look Up Fields
Form Templates
Fast Fill Button
. Clauses (saved text and clauses)

Tools, such as Spell Check

Templates and Synchronizing Files

1. Creating your own template

2. Sending your files from Standard (desktop) to
Professional (online) storage.

Notes:

How to Sign Up for zipForm® 6

= Visit your association website
to take full advantage of
member benefits

» |f zipForm® is not part of your
association or brokerage
benefits, sign up at:
www.zipLogix.com/zf6

e

www.zipLogix.com/zf6



zipForm® 6 Training

zipForm® 6 Standard:

Double-click on the
ZipForm® 6 icon

zipForm® &

Double-click

zipForm® 6 Professional:
Open your internet browser

Visit your sign in page

(www.zipFormOnline.com)
Sign in using your username and

password

Notes:

Starting a new transaction file in
zipForm® 6 Professional (online)

Zipform 6"
e B FORMS e

Welcome Back fraining

Transaction List I

E

HEW
TRANSACTION

Clause Manager

Template List

adding forms

Menu  Name
221 Baker Street - Holmes - Broker # 4568
456 Rainy Drive - Dary| - Broker # 234532

234 Weekend Way - Frank J Seller

456 Snowy Way

www.zipLogix.com/zf6

Or label a transaction file before

Click the “Forms” tab to start filling out
contracts instantly

@ LOGOFF | & PROFILE | ' SHOP | &3 surPoRT

My Profile Library Manager RELAY Manager
| Transaction Sea | | Active Transactions v“ >
]
Status Seller Buyer Modified « Created
Active Donald W. Risch 12712010 1i27/2010

10:38:37 AM 10:32:34 AN

12002010 1/20/2010

. G
e ar ol o 10:55:26 AM 10:35:31 AW
1ME2010 11572010
W,
Ache Do W et 75525 AN T:40:01 AW
3
. 1132010 12182009

110512 AM 10:47.37 AW

zipform 6




zipForm® 6 Training

Select your forms

PROFILE | T 8HOP. ..l SUPPORT

File > Hit =7 Tools Help =

L+ Standard users can click the “New Transaction”
maisacon o button here, or start adding forms below
I Fo 0ol | © kw5
4

My Transaction Forms ¥
D 783 Main Street-- Broker (D - 12345

Remove Selected Forms

rm Demonstration Library |v|

Alphabetic

Numeric Categorized

-Transaction Cover Sheet - _COVER

Additional Provisions Addendum - AAP W DOUbIe_CIICk to Open a form, Or CIICk

Buy - Sell Agreement (7 Page) - BUYSELL and drag the form to your transaction
Counter Offer - CO

Lead-Based Paint Disclosure - LBPD
Option to Purchase - OTP

Standard Listing Contract - SLC

Notes:

The forms panel

My Transaction Forms
& 789 Main Street-- Broker I0- 12345
¢ & _COVER - Transaction Cover Sheet

Click to show or hide

[ Page1 the forms panel
This form is part of %:325
your file. Click to [} Page 4

open and fill it out.

‘ 38 Remove Selected Forms |

= e
Library Forms:
[1PDEMO - ZipForm Demanstration Library v

Select your library of
blank forms here

View forms

alphabetically, by
form number, by
category, or search
for a specific form

Alphabetic Numeric Categorized Search

[] .Transaction Cover Sheet - _COVER
Additional Provisions Addendum - AAP
Buy - Sell Agreement (7 Page) - BUYSELL
Counter Offer - CO

Lead-Based Paint Disclosure - LBPD
Option to Purchase - OTP
Standard Listing Contract - SLC

This icon means this
form is already part
of your file

zipform 6

www.zipLogix.com/zf6



zipForm® 6 Training

Apply Your Template(s)

A template saves you time by adding the forms and
information you use in every transaction

Apply Template

B

T

MEM!
TRANSACTION

Select the template you want to add to this transaction

note: Applying & termplate will populate empty fields with termplate
data. IFtransaction already has forme that have heen filled in, some
- ofthese values may get changed

Create Template |
Apply Template

Click “Apply Template”
on the “File” menu

TEMFLATE OFEM MENL HELF

(FILE MEMNLI

Sale Template
Residential Listing - PA
Listing Template

Click the appropriate
template name (apply
office templates first)

o 4 Click OK zipform 6

Notes:

The Cover Sheet Form

= Contains basic information about the file

» Information entered here is copied to all forms

COVER . Transaction Cover Shest Yo @@k |n © Ofoewen |4 @G@& 5 AT
iy Transaction Ferms. ]
Untitied
WER T
PROPERTY INFORMATION i
MLS Mumber 1215 Enter file
123 Main Btemat : :
St Address P information
Township: Local Township
Counly Cantral County
Stain ar
Zip Code: 12:5
Lagal Descrigtion
Parcel or Tax D8
Listing Dale
B Remove Selected Fams Listing Expiratice: Dale
. - Listed Price: § 358,000, 60
X Balance of 151 Mangage 51.234.00
oy Forma: Balance of 2nd Morigage:  §4,367.00
TIPOEMO . ZipForm Domonstration Library - Othar Lins. <321.00
) Descriphon of Ofer Liens Home Isprovessnt Loan
Mphabelic — Mumeric  Categoriced | Search Total Encumbrances §6.122.00
Trasaction Cover Shoot - _COVER Homeowner Assoc. Dues:  § Homoomner Asso. Name
[ Additional Provisins Addandam . AAR :'Ul-*'fr 'Fl-"_:ﬂ;
Counter Offer - CO it o
Lead. Rased Paint Disclosure . LBPD -
Standard Listing Contract - SLC g plemarrind e
Purchase Price Somsament Date
Puschase Agreamarnt Date:
Depast Amaunt 5 PossessionOooupancy Dute
Diopest Amaunt 15t Incraass: §

www.zipLogix.com/zf6
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Notes:

Entering Data

Look Up fields save you time with information you
have already entered

MLS Mumber:

Street Address:

City:

Towuns hio:
Click on an entry in the list to
automatically fill in this form field.

To remove an item or edit your

look up fields, go to the “Edit”
menu, then click “Look Up Fiel

1253 Hain Street

FORMS

s p—

LOdkK UF FAST FILL
FIELDS

ds”

2|
MENU HELF
(EDIT MENLY

www.zipLogix.com/zf6

Navigating through your forms

‘j.ovERr .Transaction Cover Sheet

My ion Forms ¥
= 789 Main Street-- Braker ID - 12345 8
¢ & _COVER- Transaction Cover Sheet

[ Page 1
[y Page 2
[ Page 3

[y Pages

Select your form

#8 Remove Selected Forms
i

Library Forms:
ZIPDEMO - ZipForm Demenstration Library

Change the page

oe ek « ©emm S E
=

TRANSACTION "~

ML Number
St Address:
City:

Tovns, o

ra=m EXpand the form to
Listing Bi .

wiger fill your screen
Listed Pri

Balance of 1stMortgage:

Baience ot 20 Nirgaa:

Other Liens:

Description of Other Liens:

Homeowner Assoc. Dues:

Property Includes:

Propery Evehes

Leased |tems:

Infa:

Alphabetic Numeric Categorized

[ -Transaction Cover Sheet - _COVER
Additional Provisions Addendum - AAP
Buy - Sell Agreement (7 Page) - BUYSELL
Counter Offer - CO
Lead-Based Paint Disclosure - LBPD
Optionto Purchase - OTP
Standard Listing Contract - SLC

Purchase Price:
Purshase Agreement Date:
Deposit Amount

Deposit Amaunt TstIncrease
Deposit Amount2nd Increase
Deposit Amount 3rd Increase:
Offer Date:

Offer Expire D ate

Offer Acceptance D ate

Total Amount Financed:
Year Buik

FROFERTY T 7y om) in/out

Homeowner Assoc. Name:

Settlement Date:

Possession/Oceupancy Date

Offer Expire Time
O AWM OPM

Ziptorm 6




zipForm® 6 Training

Some Useful Form Buttons

Na H B O =

Cut / Copy / Paste
= Use these buttons to cut, copy, or paste highlighted text in fields

Strike out
= Click strike out, then highlight the text you want to line out, or highlight
again to remove a strike out (not available in some areas)

B Uppercase / Lowercase

= Change the text of a field to all uppercase, all lowercase, or capitalize the
first letter of each word

T N/A
= Fill'in all blank fields with “N/A” or text of your choosing

PRl Sticky Notes
: = Post a note on your form (Notes will not print)
Fast Fill

= View all of the fields in the form to fill them out quickly
Undo / Redo

= Undo or redo the last action on this form

d

Notes:

Keyboard Shortcuts

Page Up — Move up one = Down arrow key — Scroll through
page Look Up Fields

Page Down — Move Space Bar — Check off the current
down one page check box

Home — Jump to the first Space Bar (in a formatted field,
page of a form i.e.: date) — Overrides automatic
End — Jump to the last formatting

page of the form CTRL + C — Copy

Tab — Go to the next CTRL + X — Cut
form field CTRL +V — Paste

Enter — Go to the next CTRL + Z — Undo
form field

www.zipLogix.com/zf6



zipForm® 6 Training

Notes:

The File Menu

Helpful menus are at the top of your forms screen

Click to expand the file menu

Edit = Tools Er

| K = . ’ i@ vy, i =)

L+ 8 x| ‘*;_1‘,_ | s = —d 7]
HEW TEMPLATE QOFPEN CLOSE SAVE SAVE AS PRINT EMAIL Fax eSign MEMNL HELP
TRANSACTION o FDF = i (FILE MENLY

Print Current Form
Print All Forms
Print Blank Form
Print Sample Form

Sign
Check Status

Help and
FAQs

Create Template i
Apply Template f

Save
this file

Create a new
transaction

Open a
saved file

Print forms

Send forms
to an email
address

Create or apply
a template

(a saved set of
forms)

Save as a
PDF to your
computer

Close this
file

Send for
electronic
signatures | 67)

www.zipLogix.com/zf6

The Edit Menu

Helpful menus are at the top of your forms screen

Click to expand the edit menu

Help

d < 7]

EDIT CLAUSES Lok UP FAST FILL MENU HELF
HEADER FIELDS (EDIT MENLU)

New Note

Show All
Edit, use or Hide All
add clauses | peetean || Edit look up
(saved text fields (saved
for filling in form field
forms) entries)

Edit the name
and basic file Add or edit View all of the
information sticky notes form fields Zipfc-rm 67




zipForm® 6 Training

The Tools Menu

Click to expand the tools menu

E= -

= - . : <
E ) -

J 1h e 17

SPELL CHECK MORTGAGE MLS CONMECT OFTIONS ADDRESS MENU HELF

— CALCULATOR BOOK (TOOLES MENLY

i
| Current Form Only
i All Forms In Transaction

Calculate A Help and
mortgage settings, FAQs
rates and such as

payments auto-save
intervals

Check your Import property Address Book
spelling information from of contacts
a participating ¥
MLS zipform 6

Notes:

Templates

= The electronic equivalent of your “pre-
packaged” folders

= Contain the forms for a listing or the
forms for a sale based on the type of
template created

= Can contain your agent information and
other saved information

zipform 6

www.zipLogix.com/zf6



zipForm® 6 Training

Notes:

Creating Templates

1.
2.
S

TRANSACTION

Click Create Template
Label the template
(OPTIONAL) You can use an existing template to start your new template

x| 7]
TEMPLATE OPEN CLOSE  SAVE SAVEAS  PRINT  EMAIL  MENU HELP
e (FILE MENU)

v

el Mme the Template

1. Click Create
Template

[ Untitied|

Library Forms:

My Transaction Forms

Remowv

Template Name: My Listing Template |
Template Type Property Type Status
® Listing ® Residential  Industrial ® Agent
_) Purchase ) Commercial ) Vacant Land Global
O Lease ) Multi Unit 2 Office
3. Apply a
Apply Template: Listing Template .| template to
— start (optional
o] (9ptiona)

Alphabetic

ZIPDEMO - ZipForm Demonstration Library

Numeric

Transaction Cover Sheet . _COVER - (ZIPDEMO)

Categorized Search

www.zipLogix.com/zf6

Creating Templates

4.

Place forms you need into the template (by either dragging and dropping
or double clicking on the forms in the bottom left box)
Forms that are part of the template appear under “My Transaction Forms”

Fill out the form fields with the data you want in every tr
Save and repeat these steps for additional templates
File Bt Tools H 7. Save
I [ f [or | @ =
+ \ ve M L = o}
NEW TEMFLATE OFEN CLOSE SHVE SAVE A5 FRINT EtAIL MENU HELF
TRANSACTION FOF (FILE WENL)
v v
|_COVER - .Transaction Cover Sheet FoD O @)k n © Ofcawdn (Y| X @7 S 2 n ot E e A
My Transaction Forms : g?m';wphma Nambar
& My Listing Temnplate Eus\aﬁs;hcm Number:
o [ 5LC- Standard Listing Confract ax Numbar:
o & LBPD - Lead-Based Faint Disclosure E:“:B‘,:h:::_mmm
o [ AAP - Additional Provisions Addendurm Seller 3 Marital Stas:
¢ & _COVER - Transaction Caver Sheet SELLING BROKER INFORMATION
D FEDE 1 Salling Broker Firm Nama. Salling Offica 1D#:
Streat Address:
Page 2 City.
| D ] Stak:
A [ Page 3 Zip Codar
Telephona Number:
Fax Number:
5. Template forms Seting Broker Nama . ;
I Seting Aot Nom 6. Fill out form fields g agen os
‘Agent's Phone Number
4. Add form selected Forms g:g:"a' Phone Numbar
Email Addrass:
. LISTING BROKER IN. ORMATION
Library Forms: Listin Brcker Fim Nama: __ [JjsisLogis Brokerags = Listing Offica ID#:
PDEMO - ZipForm Demonstration Library |v ‘ Steat Address: 123 Broker way
iy ciey
. Stale:
Alphabetic Numeric Categorized Search Zip Code: ::3-5
8 318-266
Transaction Cover Sheet -_COVER - (ZIPDEMO) H o umber (ean)3za-2es0
- i 400 g B

10



zipForm® 6 Training

Notes:

More on Templates

= Fill in all blanks that require your name and
address, brokerage, or standard includes,
for instance.

= Templates prevent you from needing to
retype this information every time you start
a new contract.

File

[t New Transaction

.ﬂ Template » (x| |%:j.w

fé SI:ZI; wre oeed o close cwe f You can also create templates

e : 'SM from a transaction by selecting

TR s “Save As Template” from the

H Manage Files Save As Template drop-down file menu ¥ _
e zipform 6

www.zipLogix.com/zf6

zipForm® 6 Professional Home Page

Work online, from anywhere

Easily navigate settings and files Update Profile/Company Information

Qe HOME % @ LOGOFF | & PROFLE | FfsHOP | [l sUPPORT

Welcome Back training

Transaction List Template List Clause Manager My Profile Library Manager RELAY Manager
|+ New transaction : a Sea | !Acuve Transactions : >

new Search files e
TRANSACTION vanced e

Click or hover to expand the transaction menu
Menu  Name, Status Seller Buyer Modified & Created

12712010 12772010

j 2 " 5 W |
27\ Baker Street - Holmes - Broker # 45658 Active Donald W. Risch St AR T A
e : % 12002010 12012010
k- = 3 "
@ 456 Rainy Drive - Daryl - Broker # 234532 Active Donald W. Risch el
Open £i Delete A Edit Header Active Donald W. Risch 1152010 14152010
o : R T:55:25 A T:40:01 AM
Copy Email s Partners
Documents " Contacts i Sync with RELAY At 1132010 12116/2008

110512 AM 10:47.37 AW

11



zipForm® 6 Training

zipForm® 6 Elite (Standard + Professional)

File Edit — - Tools =~ Help =~
] @ Open your Options to connect your Standard (desktop)
& . .
el check womesce ormos  cneck @CCOUNE to your Professional (online) account
— CALCULATOR UPDATES [TO0Ls MEHU)
m Click Account Tab
My Transaction Forms
Account Pri E-Sii C
zipLogix Account
NAR Info Credentials Association
Username: ‘dawstraimng |
Password: [seensces |
‘7 d Forr zipForm® 6 Professional Account Enter yOUr ZipFOrm@ 6
— - Toaw Naivie [aicing Professional username
ZIPDEMO - ZipForm Demonstration Library Password; [seneoee | and passwo rd
nphebetic  [TEEEER B8 . How do | get rmy zipForm & Profassional usernarr 2
.Transaction Cover Sheet - _COVER Click OK

Additional Provisions Addendum - AAP
Counter Offer - CO

Lead-Based Paint Disclosure - LBPD
Standard Listing Contract - SLC

oK Cancal

Notes:

zipForm® 6 Elite (Standard + Professional)

B8 zipForm@ 6 Standard

file k0 Click the drop-down file menu to manage files

(s New Transaction from zipForm® 6 Standard
Template 4 1

q
o u

5 Open E OFEN CLOSE SAVE GSAVEAS  PRINT  EMAIL  MENUHELP Check “Include

£ Close FOF - (FILE MENU)

online files”

Save 3
PDF
Seancl: i Wnchude ofine fles
E Manage Files I=|
Templates
Print 3 5 our aned ocal
‘ Clauses
Send Email ) B - il s savedd ofting onty. B - Onlio fle hirs changed, ot B ek
E-Signature - Hile i warved onlne ondy, i) - changud, W - Sy slalus s unamailable
Lock/Unlock 1 Guily that e b 14 montles wil bo symeed.
5 Hep Trang aclion Name Trangashon Trwa ] Propeny Trme By Seller | Last\pdated ¥ | Sme Stanus |
Linnes Ave | Listing | Residential | 1 0203101158 | E
O Exit 231 Bahar S¥aet - Hornes - Broker # 4568 | Dona riseh
456 Snowy Way |1

Recent Transactions »
Also manage

Templates and
Clauses

Select one or more files to copy,
import, export, or delete

Showing 7 ransactions,

e Sxlanind 1w mean Eapin Clam

Click “Sync All” to update all files

www.zipLogix.com/zf6
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Which version is right for me?

zipForm® 6 Standard Edition
= Only works on your desktop, not available from any other computer
= Use this version if:
= You do not have regular access to an internet connection
= You do not want your files backed up online
zipForm® 6 Professional Edition
= Works online, from any computer

= All you need is a username and password to sign in securely
= Use this version if:

= You work at home and in the office
= You don’t want to carry files back and forth
zipForm® 6 Elite Edition
= Allows you to work online or offline
= Use this version if:
= You sometimes don't have a steady internet connection
= You want online backups and the convenience of your files online

Notes:

Broker Enhancements

zipForm® Professional Broker Version
= Broker of record can access all transactions online
= Work with everyone in your office

Custom company logos and forms
= Add custom company logos

= Add custom broker forms for your office

relay® Transaction Management

= Access and store transaction files for every agent online or
on CD

Save money and time with electronic document, workflow,
and contact management

Call 866-MY FORMS for pricing and details.

www.zipLogix.com/zf6
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Notes:

Need Help? Videos and F.A.Q. available 24/7

9 i iLE - i
LOGOFF | & PROFILE. | T&HoP | [ SUPPORT
File ¥ Edit b Tools — = Help
{ -~ o @ = i
o g L = B Help for this menu
= TEMPLATE ~ OFEN  CLOSE  GAVE  SAVE Af FRINT  EMAIL  MENU HELP
TRANSACTION = FOF - (FILE MENLY
Support page
| COVER - .Transaction Cover Sheet Help tab (<] iz n @O X Q@S a >
My Transaction Forms : "
= ity Listing Template
o= & SLC - Standard Listing Confract .
¢ & LBPD - Lead-Based Paint Disclosure Eﬂ:&:";g;"“m"
o= I AAP - Additional Provisions Addendum Seller 3 Marital Status:
¢ & _COVER - Transaction Cover Sheet SELLING BROKER INFORMATION
Fage

Selling Brakar Firm Nam:

Salling Office D4

e =
¥ 0O
FAQ KNOWLEDGE  ZIFFORM  HOW TO ABOUT
BASE STORE WVIDEDS ZIFFORM G

www.zipLogix.com/zf6

Thank You

www.zipLogix.com
Sign in at:
www.zipFormOnline.com

Support.zipLogix.com
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